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Chapter 1: Fundamentals  

Module A: Getting around  
Which of the following are ways to interact with Excel? Choose all that apply. 

 Click buttons on the ribbon.  

 Use the Start menu. 

 Click buttons on the Quick Access toolbar.  

 Use the Control Panel. 

Excel columns are identified by numbers. True or false? 

 True 

 False  

How many rows are there in an Excel worksheet? Choose the best response. 

 About 50,000. 

 Under 200,000. 

 Over half a million. 

 Over a million.  

Module B: Workbook basics  
The Open command is on the Edit tab of the ribbon. True or false? 

 True 

 False  

When you use the scroll bars, the active cell does not change. True or false? 

 True  

 False 

Which of the following techniques moves the active cell one column to the right? Choose all that apply. 

 Pressing Home. 

 Pressing the Right Arrow key.  

 Pressing Tab.  

 Clicking in the Name box. 

Which command do you use if you want to change the name, location, or type of a workbook? 

 Save 

 Save As  
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Chapter 2: Creating worksheets  

Module A: Entering data  
By default, Excel left-aligns all data that you enter. True or false? 

 True 

 False  

How does Excel handle text that is too wide for the column in which it appears? 

 By cutting it off at the right-hand border of the cell. 

 By spilling the text over into the next column. 

 It depends on what is in the next cell to the right.  

You can change the width of a column by using the mouse. True or false? 

 True  

 False 

Which of the following are ways that Excel handles numbers that are too wide for a cell? Choose all that 

apply. 

 Scientific notation  

 Binary 

 Number signs (####)  

 Rounding the stored number 
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Module B: Formulas  
Which of the following signals the beginning of a formula? 

 Apostrophe (') 

 Equal sign (=)  

 Any cell reference. 

 The letter f. 

It is good practice to put formulas in the first column of a worksheet. True or false? 

 True 

 False  

Which of the following is evaluated last in the Excel order of operations? 

 Multiplication 

 Subtraction  

 Percentage 

 Exponents 

Which of the following are ways to edit a formula in Excel? Choose all that apply. 

 Double-click a cell.  

 Press F2.  

 Press Esc. 

 Click in the formula bar.  

Module C: Functions  
Functions are a type of formula. True or False? 

 True  

 False 

Functions can be entered only in the formula bar. True or False? 

 True 

 False  

Which of the following is the name for the values on which a function takes action or performs calculations? 

 Variables 

 Parameters 

 Arguments  
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Which of the following are ways that you can enter function arguments? 

 Typing.  

 The mouse.  

 The Insert Arguments button. 

 The Function Arguments window.  

AutoSum can be used to enter only SUM() functions. True or False? 

 True 

 False  

Module D: Moving and copying data  
You use the Copy command to move data. True or false? 

 True 

 False  

Which of the following can be accomplished by dragging? Choose the one correct answer. 

 Moving but not copying. 

 Copying but not moving. 

 Both moving and copying.  

What is the keyboard shortcut to undo the most recent action? 

 F1 

 Ctrl+U 

 Ctrl+Z  

 Alt+X 

To copy data by dragging, which key do you hold down? 

 Shift 

 Ctrl  

 Alt 

When you paste a copied formula, Excel updates references in the pasted formula relative to the new location. 

 True  

 False 
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Module E: Reference types  
All references in Excel are relative, in terms of their location. True or false? 

 True 

 False  

Which type of reference is best for referring to a multiplier value that is in one cell on a worksheet for all 

formulas, no matter where the formulas are? 

 Mixed 

 Relative 

 Absolute  

Which character do you use to make a reference absolute? 

 Colon (:) 

 Dollar sign ($)  

 Ampersand (&) 

 Number sign (#) 

You can use the F3 key to toggle through reference types while you enter a formula. True or false? 

 True 

 False  
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Chapter 3: Formatting  

Module A: Text formatting  
To format a cell, you click the formatting button before selecting the cell you want to format. True or false? 

 True 

 False  

Which key do you hold down to add another cell or range to a selection? 

 Ctrl  

 Shift 

 Alt 

Module B: Number formatting  
When you change a number format, you change the underlying data. True or false? 

 True 

 False  

Which of the following is not a category of Excel number formats? 

 Currency 

 Exponent  

 Percentage 

 Date 

Which key enables you to extend a selection by using the arrow keys? 

 Shift  

 Ctrl 

 Alt 

How are dates stored in Excel? 

 As two pieces of data, a combination of a date and a time 

 In the format in which you enter them 

 As serial numbers  
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Module C: Alignment  
You can align cell contents: 

 Horizontally but not vertically. 

 Vertically but not horizontally. 

 Both vertically and horizontally.  

You cannot wrap text in Excel. True or false? 

 True 

 False  

The Merge & Center command is most useful for which of the following? 

 Data values. 

 Column headings. 

 Overall worksheet headings and subheadings.  

Module D: Borders and highlighting  
Which of the following are ways to apply borders to a cell or range? Choose all that apply. 

 Use buttons in the Borders menu.  

 Double-click cell borders. 

 Use the Draw Border feature.  

 Use the Borders tab of the Format Cells window.  

Thin and thick lines are the only border style options. True or false? 

 True 

 False  

Module E: Styles and themes  
You have to create a style before using one. True or false? 

 True 

 False  

Which of the following can a style include? Choose all that apply. 

 Number format  

 Formulas 

 Text format  

 Borders  

 Shading  
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Which of the following statements is most accurate? Choose only one. 

 Table styles never include headings. 

 Table styles may or may not include headings.  

 Table styles always include headings. 

Which elements of a theme can you control individually? Choose all that apply. 

 Borders 

 Font  

 Number formats 

 Colors  

 Effects  
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Chapter 4: Manipulating data  
You will learn: 

 How to use various techniques to enter similar data quickly 

 How to paste parts of cell data and formats 

 How to insert, delete, and hide cells, ranges, and worksheets 

Learning time: 45 minutes 

Module A: Data entry shortcuts  
You can use the Fill commands to extend series. True or false? 

 True 

 False  

Auto Fill recognizes any series from a single value. True or false? 

 True 

 False  

What could you do if you used Auto Fill and Excel copied instead of creating a series? Choose all that apply. 

 Enter the series manually.  

 Use the Fill, Series command. 

 Try entering the first two values in the series before using Auto Fill.  

 Try the Auto Fill Options button.  

You can only replace found text one item at a time. True or false? 

 True 

 False  

Module B: Paste options  
You can copy only the formulas of a cell or range, and not the formats or values. True or false? 

 True 

 False  

How do you use the Format Painter to copy formatting to more than one destination? 

 Hold down Ctrl while clicking the Format Painter. 

 Double-click the Format Painter.  

 Hold down Shift while clicking the Format Painter. 

 Hold down Alt while clicking the destination ranges. 
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When you paste values, Excel creates a link to the source data. True or false? 

 True 

 False  

Which of the following are possible with linking? Choose all that apply. 

 Linking within a worksheet.  

 Linking between worksheets in the same workbook.  

 Linking between worksheets in different workbooks.  

Module C: Inserting, deleting, and hiding  
When inserting or deleting, you do not always need to specify how to shift cells. True or false? 

 True  

 False 

When you insert in a range referred to by a formula, under which circumstances does Excel automatically 

update the formula? 

 When you insert within the endpoints of the reference, but not at the edge of the reference.  

 When you insert at the edge of the reference, but not within the endpoints of the reference. 

 Both when you insert within the endpoints of a reference and when you insert at the edge of a reference. 

When you hide a row or column, its data is removed from the workbook. True or false? 

 True 

 False  
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Chapter 5: Charts  

Module A: Creating charts  
You should not select labels when selecting data for a chart. True or false? 

 True 

 False  

How do you update a chart after changing its source data? 

 By press F9. 

 By clicking the Update button on the Design tab of the ribbon. 

 You don't need to do anything, because the chart will update automatically.  

Which of the following are ways to move a chart? Choose all that apply. 

 By selecting the chart and using the arrow keys. 

 By dragging.  

 By clicking the Move Chart button.  

Module B: Chart types and elements  
You can specify the type for a chart only when you create the chart. True or false? 

 True 

 False  

Which type of chart is best for showing trends? 

 Pie 

 Line  

 Column 

 Scatter 

The only way to change the axis Excel uses for your data is to transpose the data in a worksheet and create a 

new chart. True or false? 

 True 

 False  

Not all chart elements come from the data you select when you create the chart. True or false? 

 True  

 False 
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The only way to control the format of the value axis numbers by changing the format in the source data. True 

or false? 

 True 

 False  
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Chapter 6: Output  

Module A: Managing worksheet windows  
The Split command always creates four window panes. True or false? 

 True 

 False  

You do not have to split windows before freezing panes. True or False? 

 True  

 False 

Module B: Printing worksheets  
Where can you find the Print command in Excel? 

 On the ribbon's Home tab. 

 In Backstage view (by clicking File).  

 On the ribbon's Page Layout tab. 

 On the ribbon's View tab. 

You can control many aspects of how a worksheet prints on the Page Layout tab. True or false? 

 True  

 False 

What is the best way to show column headings on every page of a printout? 

 Break your data up and enter headings after every page break. 

 On the Page Layout tab, under Headings, click Print. 

 Set a row or rows and print titles for the worksheet.  

In which view can you create headers and footers? 

 Page Layout view  

 Page Break preview 

 Normal view 

 A custom view 

The Header & Footer Tools Design tab has tools for formatting. True or false? 

 True 

 False  



Excel 2016 Level 1: Answer Key 14 © 2017 30 Bird Media 

Module C: Sharing workbooks  
Which format is the best option if you want to show a workbook to someone who might not have Excel? 

 Excel 97-2003 Workbook 

 CSV 

 PDF  

 Open Document Spreadsheet 

You need to open your mail program to send a workbook as an attachment. True or false? 

 True 

 False  
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Chapter 7: Settings and templates  

Module A: Workbook options and properties  
You can control display options for Excel as a whole, for a particular workbook, or for a particular worksheet. 

True or false? 

 True  

 False 

The document property called "Title" is the same as the workbook's file name. True or false? 

 True 

 False  

What is the best way to remove personal information from a workbook's properties? Choose the best answer. 

 Remove the properties carefully, one at a time. 

 Use the Document Inspector.  

 Copy all of its data to a new, blank workbook. 

After attempting to fix an accessibility issue, you must choose the Check Accessibility command again to see 

if you've fixed the issue. True or false? 

 True 

 False  

Module B: Templates  
When you create a new workbook from a template, you are editing the actual template. True or false? 

 True 

 False  

Which of the following are reasons to save a template in the default templates folder? Choose all that apply. 

 Because you cannot save them anywhere else. 

 Because the template shows up with your others in the Personal category when you create new 

files.  

 Because it is easy to find when you want to edit it.  

Data is not stored with a template. True or false? 

 True 

 False  


